Contents

Introduction to Wisconsin’s Statewide Vital Records Information System (SVRIS) ........4

What is the Wisconsin Statewide Vital Records Information System .................................................................................................................. 4

What are the capabilities of SVRIS for Coroners / Medical Examiners ................................................................. 4

How Death Records Flow in SVRIS .................................................................................................................................................. 5

Becoming a SVRIS User .................................................................................................................................................. 6

User Roles in SVRIS .................................................................................................................................................. 7

What is a user role? .................................................................................................................................................. 7

Coroner/Medical Examiner (C/ME) User Roles .......................................................................................................................... 7

Logging into SVRIS .................................................................................................................................................. 8

How SVRIS is Organized .................................................................................................................................................. 11

Using SVRIS Work Queues .................................................................................................................................................. 12

What are Work Queues .................................................................................................................................................. 12

Locating the Work Queues .................................................................................................................................................. 12

Work Queues Available to the Coroner/Medical Examiner .......................................................................................................................... 12

Death Record Layout .................................................................................................................................................. 14

Completing the Medical Certification .................................................................................................................................................. 15

Funeral Director Initiates Death Record with C/ME as Medical Certifier .............................................................................................................. 15

Coroner/Medical Examiner Initiates the Death Record .......................................................................................................................... 16

C/ME Takes Jurisdiction of Physician-Assigned Record .......................................................................................................................... 17

• Death Record not signed by Funeral Director .......................................................................................................................... 17

• Death Record signed by Funeral Director and has a state file number .......................................................................................................................... 17

Rejected Records .................................................................................................................................................. 18

Rejecting and Returning a Record to the Funeral Director .......................................................................................................................... 18

Responding to a Rejected Record .................................................................................................................................................. 18

SVRIS Tabs .................................................................................................................................................. 20

Decedent Tab .................................................................................................................................................. 20

Decedent Demographic Tab ........................................................................................................................................ 24

Decedent Statistics Tab ........................................................................................................................................ 24

Disposition Tab .................................................................................................................................................. 25

Certifier Tab .................................................................................................................................................. 27

Cause of Death Tab .................................................................................................................................................. 28

Signatures Tab .................................................................................................................................................. 32

Edit Screen Messages .................................................................................................................................................. 33

Searching for Death Records .................................................................................................................................................. 35
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Wildcards in a search</td>
<td>38</td>
</tr>
<tr>
<td>Using Parameters in a search</td>
<td>38</td>
</tr>
<tr>
<td>Amending a Death Record (Including Completing a Pending Record)</td>
<td>39</td>
</tr>
<tr>
<td>Requesting an Amendment</td>
<td>39</td>
</tr>
<tr>
<td>Rejected Amendments</td>
<td>42</td>
</tr>
<tr>
<td>Responding to Death Record Queries</td>
<td>46</td>
</tr>
<tr>
<td>Messaging</td>
<td>49</td>
</tr>
<tr>
<td>Creating a Message</td>
<td>49</td>
</tr>
<tr>
<td>Unread Messages</td>
<td>52</td>
</tr>
<tr>
<td>Replying to a Message</td>
<td>53</td>
</tr>
<tr>
<td>Linking a Death Record to a Message</td>
<td>53</td>
</tr>
<tr>
<td>Death Reports</td>
<td>55</td>
</tr>
<tr>
<td>Available Death Reports</td>
<td>55</td>
</tr>
<tr>
<td>Accessing Reports</td>
<td>56</td>
</tr>
<tr>
<td>Running (Printing) Reports</td>
<td>57</td>
</tr>
<tr>
<td>Saving a Report</td>
<td>59</td>
</tr>
<tr>
<td>CRITICAL EXCEPTION: Wisconsin C/ME Notification Report</td>
<td>60</td>
</tr>
<tr>
<td>Printing Documents</td>
<td>61</td>
</tr>
<tr>
<td>Blank Forms</td>
<td>61</td>
</tr>
<tr>
<td>Populated Documents</td>
<td>62</td>
</tr>
<tr>
<td>Appendix</td>
<td>63</td>
</tr>
<tr>
<td>Help Text</td>
<td>64</td>
</tr>
<tr>
<td>Hint Text</td>
<td>64</td>
</tr>
<tr>
<td>Review Errors and Queries</td>
<td>65</td>
</tr>
<tr>
<td>System Preferences</td>
<td>66</td>
</tr>
<tr>
<td>Turning off the Error Beep</td>
<td>66</td>
</tr>
<tr>
<td>Changing Background Color</td>
<td>67</td>
</tr>
<tr>
<td>SVRIS Keyboard Shortcuts</td>
<td>68</td>
</tr>
<tr>
<td>Wisconsin Help Desk Contact Information</td>
<td>69</td>
</tr>
</tbody>
</table>
Introduction to Wisconsin’s Statewide Vital Records Information System (SVRIS)

What is the Wisconsin Statewide Vital Records Information System

The Wisconsin Statewide Vital Records Information System (SVRIS) is an automated, secure, web-based software application designed to process vital records from point of initial entry and certification through registration and assignment of the State File Number.

As of September 2013, Phases I and II of SVRIS have been implemented. This includes entry and certification of birth and fetal death records and entry and registration of death records.

Future phases of SVRIS include the incorporation of marriage, domestic partnership, divorce, and termination of domestic partnership records.

What are the capabilities of SVRIS for Coroners / Medical Examiners

Coroners/Medical Examiners (C/ME) will have access to all records in their jurisdictions. Cause-of-death information will be entered electronically. C/MEs will have the ability to initiate a death record, enter the cause of death, and request amendments. Reports and one export can be run on demand with real time data.
How Death Records Flow in SVRIS

The basic flow of death records in SVRIS is similar to the paper process.

Funeral Director (or Coroner/Medical Examiner) initiates death record in SVRIS by entering decedent’s personal information.

Funeral Director reviews information with family.

Funeral Director makes any necessary changes to the death record.

Funeral Director selects the Medical Certifier and saves the record.

Death record is routed to the Work Queue of the Medical Certifier.

Medical Certifier locates death record in Death MC In Progress Work Queue.

Medical Certifier reviews the death record; enters cause-of-death information; and electronically signs and certifies the death record.

The death record is routed to the Funeral Director's Work Queue.

Funeral Director reviews death record and electronically signs. Death record is routed to the Local Vital Records Office (LVRO) Work Queue.

LVRO accepts the death record.

State Vital Records Office (SVRO) registers the death record.
Becoming a SVRIS User

In order to request access to SVRIS, you will need to set up your SVRIS User Account and report your SVRIS User Account ID to the State Vital Records Office (SVRO) on the Access Request form (as discussed below) before your account is activated. (Do not report your password to SVRO.) A SVRIS User Account must be set up by each staff person using SVRIS. Accounts must not be shared.


2. Click on the “Self Registration” link under “Sign Up for your DOA/Wisconsin Logon.”

3. Read the User Agreement and click “Accept.”

4. Enter all required information. Required information is indicated by the asterisk (*) following the field. Under “Systems You Will Access,” select DHS Vital Records. Under “Account Information,” enter the Logon ID and Password you create, which you will use to gain access to SVRIS. Remember your Logon ID (which is your User ID or Logon) and Password. This is what you will use when working with SVRIS. Please note: the Logon ID cannot be more than 16 characters.

5. Click "Submit" when you have entered all the required information.

6. Fill out the “SVRIS Access Request and Confidentiality Agreement for Death Event Users” form. If you don’t have a copy, you can email DHSSVRISAdmin@wi.gov and request one. Or you can go to Netsmart University Home Page at https://www.mylearningpointe.com/svris/signinMLP.asp and click on your user group on the left side of the screen. Click on “Creating Your SVRIS User Account” from the dropdown list. Download the “SVRIS Access Request and Confidentiality Agreement for Death Event Users” form and fill in the requested information.

7. Fax both pages to (608) 261-4972.

8. Staff at the SVRO will complete the SVRIS account activation process and notify you when your SVRIS account is active. It generally takes approximately one week. You must have completed your SVRIS training before your SVRIS account is activated.

9. If you forget your Logon ID and/or Password, go to http://register.wisconsin.gov, select “Forgot Your Login ID or Password?” and enter your email address. You will receive an email with instructions on how to recover your Logon ID and Password. If you still have problems, please contact the Wisconsin Help Desk by phone at 1-866-335-2180 or by email at helpdesk@wi.gov.
User Roles in SVRIS

What is a user role?

A user role controls what a user can see and do in SVRIS. Roles regulate which records a user can access, search, and print. Each SVRIS user will have a user role.

Participants in SVRIS are distinguished by their user roles. As users register to participate in the system, they are assigned roles, which identify and define how they will use the system. SVRIS contains an electronic audit trail, by user role, of who is accessing death records, which improves accountability.

All SVRIS users should be aware of what role has been assigned to them and have a clear understanding of how that role is defined in both access and functionality in SVRIS.

Coroner/Medical Examiner (C/ME) User Roles

- **Coroner/Medical Examiner Staff View** – The C/ME Staff View role can search and display death records. Any user with this role is allowed to view death records, but does not have access to enter, change, or print information.

- **Coroner/Medical Examiner Staff** – The C/ME Staff role can create new death records, enter cause of death information, print blank and populated forms, and run reports.

- **Coroner/Medical Examiner** – The C/ME role can perform all the functions of the C/ME Staff role with additional important functions. C/MEs can electronically sign death records, request amendments, and respond to queries.

C/ME Deputies may be assigned the C/ME role, the C/ME Staff role, or the C/ME Staff View role depending on office policy.

In the event that a C/ME is acting as a Funeral Director, the C/ME should contact the Wisconsin Help Desk at 1-866-335-2180 to obtain the appropriate role.
Logging into SVRIS

Go to the SVRIS website - [https://vitalrecords.wisconsin.gov](https://vitalrecords.wisconsin.gov). For those using a Windows operating system, select the link on the left for Medical Certifiers (Physicians, CMEs and Staff). Apple users should select the link on the right for “Apple Users.”
The Login screen will open.

Enter your user ID and password and click the Login button. Do not click on any of the 4 buttons under the Login screen.

If necessary, select your role. Not all users will have multiple roles and the majority of C/ME and C/ME Staff users will not see this screen.
You will see the following message while SVRIS is loading.

![Message](image1.png)

Then the following message will appear. Click OK.

![Message](image2.png)
How SVRIS is Organized

SVRIS home screen:

Along the top of the SVRIS home screen (screen shot above), there are menus for common commands.

- The File menu allows a user to create a death record.
- The Search menu allows a user to search all deaths assigned to his or her jurisdiction and to search for a specific message.
- The Work Queue menu contains items awaiting action. By using the Work Queues, the user can track records through the registration process.
- The Tools menu is where a user can send and/or receive an email message or can access Preferences, which will allow a user to customize the screens in SVRIS.
- The Batch menu is where a user can access and run standard reports and exports.
- The Blank Forms menu is where a user can access and print standard forms to be completed manually (e.g., Cremation Release, Death Worksheet, Report for Final Disposition).
- The Help menu is where the user can find such things as how to contact the Help Desk, how to recover an ID and password, and learn about printer specifications.
Using SVRIS Work Queues

What are Work Queues
SVRIS work queues contain records waiting for action. When you complete a record in your queue, it will automatically be routed to the appropriate authority. The Funeral Director initiates the death record and marks it complete. The record will then be routed to the queue of the C/ME for cause of death and signature. The C/ME will select the record from his or her work queue, enter the cause of death, mark the medical information as complete, and electronically sign the record. It will then be routed back electronically to the Funeral Director’s queue to be completed and signed. Once the Funeral Director signs the record, it will be routed electronically to the Local Vital Records Office (LVRO) for acceptance. After the LVRO accepts the record, it will be routed electronically to the State Vital Records Office (SVRO) for registration.

Locating the Work Queues
The Work Queues are located under the Work Queue menu from the SVRIS home screen. This is a list of the various queues assigned to your role in the system. Each Work Queue will show a count of how many items are waiting in that queue. If the number is zero, nothing is in that queue.

NOTE: Periodically you will need to select the first menu item, “Refresh Work Queue Count”, this will update your queue with any new records that have arrived.

Work Queues Available to the Coroner/Medical Examiner

Refresh Work Queue Count
This will check the system for new items that have arrived for your review. Logging into the system automatically refreshes the Work Queue. If you have not logged out of the system and logged back in, this refresh will not occur and you must select “Refresh Work Queue Count” to update your queue with any new items that have arrived.
**Death Amendment Pending – MC**
Death records for which an amendment requested by the Medical Certifier is waiting for SVRO approval.

**Death Amendment Rejected – MC**
Death records for which an amendment requested by the Medical Certifier has been rejected and returned to the Medical Certifier by the SVRO.

**Death MC In Progress**
Death records assigned to the Medical Certifier to complete the medical certification (also called cause-of-death (COD) information).

**Death MC Pending COD**
Death records with a “Pending” manner and cause of death.

**Death MC Ready to Sign**
Death records for which the cause-of-death information has been entered and the records are ready to be electronically signed by the Medical Certifier.

**Death MC Reject**
Death records where the medical certification has been rejected and returned to the Medical Certifier by the Funeral Director, the SVRO, or the LVRO.

**Messages**
Internal messages. (Messages are discussed in the Messaging section.)

**Query Amendment Request – MC**
Death records where SVRO requires additional information pertaining to the cause of death.
Death Record Layout

Electronic death records are organized using tabs, paragraphs, and fields. Tabs are the major sections of a record and appear at the top of the window. Tabs are subdivided into Paragraphs, which are recognizable by the blue lines surrounding each paragraph. Each Paragraph contains individual fields.

In the example below, the first tab is the Decedent Tab. This tab contains paragraphs relating to the decedent – Overview, Deceased, Pronouncement, and Place of Death. Some of the fields in the Decedent information paragraph are first name, middle name, last name. The C/ME and C/ME Staff will need to complete fields in several tabs. These will be discussed in detail later in this manual.
Completing the Medical Certification

C/MEs have capabilities to handle several different responsibilities. First, the C/ME completes the death record as the Medical Certifier. Second, there will be times that the C/ME would need to initiate the death record for the Funeral Home. Third, the C/ME would need to take jurisdiction of a physician-assigned record. These will be discussed below.

**NOTE:** There may be times when a C/ME will act as the Funeral Director. If that occurs, the C/ME must contact the Wisconsin Help Desk to obtain the appropriate role. SVRO will assign a Funeral Director role to the C/ME. The remaining portion of the death record will then be available for entry by the C/ME using the newly created Funeral Director role.

Funeral Director Initiates Death Record with C/ME as Medical Certifier.

- Funeral Director initiates death record in SVRIS completing the following:
  - Decedent tab.
  - Decedent Demographic tab.
  - Decedent Statistics tab.
  - Disposition tab.
  - Certifier tab.
- The Funeral Director selects the C/ME from the dropdown list.
- C/ME logs into SVRIS.
- C/ME checks the Death MC In Progress Work Queue for record(s) that need the medical certification completed.
  - Click on the Work Queue menu.
  - Select Death MC In Progress.
  - In the Work Queue window, highlight the name of the appropriate record.
  - To open the record, click on Display (bottom left of the screen) or double click on the highlighted record.
- C/ME reviews decedent information on the Decedent tab of the record.
- C/ME enters the cause-of-death information.
  - Click on the Cause of Death tab.
  - Enter the required medical/cause-of-death information.
  - If an injury or poisoning is reported in the cause of death, enter “Y” in the “Injury or Poisoning” field and the injury fields will open in this paragraph for entry
- C/ME completes and signs the record.
✓ Click on the Signatures tab.
✓ Enter “Y” in the “Medical Information Complete” field. The “Completed Date” and “Completed By” will be automatically filled.
✓ Enter “Y” in the “Certifier Signed” field. The “Date Signed” and “Full Name of Certifier” will be automatically filled.
✓ Save the record. This will route it back to the Funeral Director.

**Coroner/Medical Examiner Initiates the Death Record**

When necessary, the C/ME can initiate the death record and then assign it to a Funeral Home.

It is important for the C/ME to first search SVRIS to confirm the death record has not already been initiated by another SVRIS user. If no record is found, the C/ME enters initial, basic information about the decedent, selects the Funeral Home responsible for disposition, and completes and signs the medical certification.

- C/ME logs into SVRIS.
- C/ME clicks on Search menu → Death.
- Once the Search Criteria screen opens, C/ME enters decedent’s name and date of death.
- If no record is found, a “No Record Found” message will show on the screen.
- Then the C/ME can initiate a new death record in SVRIS.
  ✓ Click on File menu → New Event → Death.
- C/ME enters data into appropriate fields of death record on the following tabs.
  ✓ Decedent tab.
  ✓ Decedent Demographics tab.
- C/ME designates a Funeral Home.
  ✓ Go to Disposition tab.
  ✓ Select Funeral Home from the dropdown list.
- C/ME completes the death record by entering data in the appropriate fields on the following tabs.
  ✓ Certifier tab.
  ✓ Cause of Death tab.
- C/ME completes and signs the death record.
  ✓ Go to Signatures tab.
  ✓ Enter “Y” in the “Medical Information Complete” field. The “Completed Date” and “Completed By” will be automatically filled.
  ✓ Enter “Y” in the “Certifier Signed” field. The “Date Signed” and “Full Name of Certifier” will be automatically filled.
Save the record. This will route the record to the Death In Progress Work Queue of the selected Funeral Home.

**C/ME Takes Jurisdiction of Physician-Assigned Record**

The C/ME can opt to assume responsibility for the medical certification of a death record in his or her jurisdiction. The two scenarios are described below.

- **Death Record not signed by Funeral Director.**
  If the death record has not been signed by the Funeral Director, the C/ME should contact the Funeral Director indicated on the Disposition tab to notify the Funeral Director that he/she is taking over the record. The Funeral Director will then change the Medical Certifier to the C/ME. After the Funeral Director makes the change and saves the record, it will appear in the Death MC In Progress Work Queue.

- **Death Record signed by Funeral Director and has a state file number.**
  If the record has been given a State File Number, it is considered registered and the C/ME will need to contact SVRO to have the death record voided. SVRO will create a new record where the C/ME will be assigned as the Medical Certifier. After the SVRO creates the new record and saves the record, it will appear in the C/ME’s Death MC In Progress Work Queue.

The system will automatically send a system and/or email message to the Funeral Director and LVRO with jurisdiction indicating the record has been voided. The message will include the notes describing the reason the record has been voided.
Rejected Records

Rejecting and Returning a Record to the Funeral Director

The C/ME can decline to certify a death record and reject it back to the Funeral Director.

- C/ME rejects the record.
  - Click on the Signatures tab.
  - Enter “Y” in the “Reject to Funeral Home” field.
  - Enter the reason for rejection to the Funeral Home. The “Last Rejected Date” and “Last Rejected By” fields will be automatically filled.
  - Save without edits (File → Save Without Edits).

**NOTE:** To prevent SVRIS from displaying error messages for fields without an entry, it is very important to use “Save Without Edits” not “Save.”

- Close the record.

Responding to a Rejected Record

The SVRO, LVRO, or Funeral Director and staff can reject death records back to the C/ME for various reasons. These rejected records will appear in the Death MC Reject Work Queue.

To review rejected records:

- C/ME checks the Death MC Reject Work Queue for record(s) that have been rejected.
  - Click on the Work Queue menu.
  - Select Death MC Reject.
  - In the Work Queue window, highlight the name of the appropriate record.
  - To open the record, click on Display (bottom left of the screen) or double click on the highlighted record.

- C/ME reviews reason rejected.
  - On the Signatures tab, review the “Reason Rejected to Medical Certifier” field.
  - Change or add any information needed.
  - Enter “Y” in “Certifier Signed?” field. The “Date Signed” and “Full Name of Certifier” fields will be automatically filled.
  - Save to resubmit the record.
In the example below, the record has been rejected back to the C/ME by the Funeral Director.

<table>
<thead>
<tr>
<th>Record Identifier</th>
<th>Decedent's Full Name</th>
<th>Date Pronounced Dead</th>
<th>County of Death</th>
<th>Record Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TO PHYSICIAN, TEST MESSAGE</td>
<td>02/14/2014</td>
<td>DANE</td>
<td>REJECTED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Record Completion</th>
<th>Medical Information Complete</th>
<th>Completed Date</th>
<th>Completed By</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>/ /</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Medical Certifier</th>
<th>Certifier Signed?</th>
<th>Date Signed</th>
<th>Full Name of Certifier</th>
<th>Last Rejected Date</th>
<th>Last Rejected By</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Y</td>
<td>/ /</td>
<td>SCHROEDER, JEFFREY O</td>
<td>02/22/2014</td>
<td>SMITH, MICHELLE M</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reason Rejected to Medical Certifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRACTURE REPORTED - MUST INDICATE NON-TRAUMATIC, REMOVED OR RECORD SIGNED BY ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Funeral Home</th>
<th>Reject to Funeral Home</th>
<th>Last Rejected Date</th>
<th>Last Rejected By</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>/ /</td>
<td>/ /</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reason Rejected to Funeral Home</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>


SVRIS Tabs

C/MEs can have several different responsibilities, so all of the tabs that may potentially need to be completed are discussed below.

Decedent Tab

The fields on the Decedent tab will typically not require entries by the C/ME since the Funeral Director completes these items. It is only necessary to complete these fields if the record is initiated by the C/ME. Fields that are open for the C/ME entry are highlighted with a red box. The fields in the Overview paragraph are system generated and may be helpful in determining the status of the record.

<table>
<thead>
<tr>
<th>First Name</th>
<th>Enter the decedent’s first name in this field. Entries of “also known as” or the addition of potential nicknames are not acceptable (e.g., Nicole (Nicky) Ann Smith). Valid characters are the 26 letters (A-Z). Acceptable punctuation includes the hyphen, space, and/or an apostrophe. If there are two or more first names, it is acceptable to put a space or a hyphen between names. If the decedent has only one name, put it in the last name field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Middle Name</td>
<td>Enter the decedent’s middle name in this field. Entries of “also known as” or the addition of potential nicknames are not acceptable (e.g., Nicole Ann (Annie) Smith). Valid characters are the 26 letters (A-Z). Acceptable punctuation includes the hyphen, space, and/or an apostrophe. If there are two or more middle names, it is acceptable to put a space or a hyphen between names. If the decedent has only one name, put it in the last name field.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the decedent’s last name in this field. Entries of “also known as” or the addition of potential nicknames are not acceptable (e.g., Nicole Ann (Annie) Smith). Valid characters are the 26 letters (A-Z). Acceptable punctuation includes the hyphen, space, and/or an apostrophe. If there are two or more last names, it is acceptable to put a space or a hyphen between names. If the decedent has only one name, put it in the last name field.</td>
</tr>
<tr>
<td>Suffix</td>
<td>Enter the decedent’s name suffix in this field if one has been given. Valid suffixes consist of characters between A and Z. Examples included: Jr., II, V, etc. Do not include credentials like MD, PhD, or prefixes like Mrs, Ms, etc. Suffixes must be represented with roman numerals (I, II, III, etc.) and cannot be represented with numbers (1st, 2nd, etc.) or punctuation.</td>
</tr>
<tr>
<td>Alias?</td>
<td>A value of “Y” indicates at least one Alias Name event exists for the record. If “Y” is entered, the following fields will open for entry. If “N” is entered, move on to the “Sex” field.</td>
</tr>
<tr>
<td>Alias First Name</td>
<td>Complete the decedent’s alias first name in this field. Valid characters are the 26 letters in the modern English alphabet. Acceptable punctuation includes the hyphen, space, and/or an apostrophe.</td>
</tr>
<tr>
<td>Alias Middle Name</td>
<td>Complete the decedent’s alias middle name in this field. Valid characters are the 26 letters in the modern English alphabet. Acceptable punctuation includes the hyphen, space, and/or an apostrophe.</td>
</tr>
<tr>
<td>Alias Last Name</td>
<td>Complete the decedent’s alias last name in this field. Valid characters are the 26 letters in the modern English alphabet. Acceptable punctuation includes the hyphen, space, and/or an apostrophe.</td>
</tr>
<tr>
<td>Alias Suffix</td>
<td>Complete the decedent’s alias name suffix in this field if one has been given. Valid suffixes consist of characters between A and Z. Examples included: Jr., II, V, etc. Do not include credentials like MD, PhD, or prefixes like Mrs, Ms, etc. Suffixes must be represented with roman numerals (I, II, III, etc.) and cannot be represented with numbers (1st, 2nd, etc.) or punctuation.</td>
</tr>
<tr>
<td>Sex</td>
<td>Enter the decedent’s sex. Enter “M” for Male, “F” for Female, or “U” for Unknown.</td>
</tr>
<tr>
<td>No SSN</td>
<td>Check box if decedent does not have a social security number.</td>
</tr>
<tr>
<td>SSN</td>
<td>Enter the decedent’s SSN. Do not enter letters, special characters, or punctuation; only numeric values can be entered in this field. If the SSN is unknown, enter “999999999.” If the individual never had an SSN, check the “No SSN” field.</td>
</tr>
<tr>
<td>Date Pronounced Dead</td>
<td>Enter the decedent’s pronounced death date in MM/DD/YYYY format. Where MM is the month (01-12), DD is the day of the month (01-31), and YYYY is the year including the century.</td>
</tr>
<tr>
<td>Time Pronounced Dead</td>
<td>Enter the time that the decedent was pronounced dead. Time of death pronounced should be entered using a 24-hour clock, i.e., 0000-2359. Only numeric values can be entered.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Pronouncer Name</strong></td>
<td>Enter pronouncer’s full name as: first name, middle name, last name suffix (if appropriate) and title. Valid characters are the 26 letters in the modern English alphabet A-Z. Acceptable punctuation includes the hyphen, space, and/or an apostrophe. A title may also be entered here if different from choices in the “Pronouncer Type” dropdown field.</td>
</tr>
<tr>
<td><strong>Pronouncer Type</strong></td>
<td>Select the pronouncer type. In Wisconsin, the following individuals are the only ones that can pronounce a death: a coroner, deputy coroner, medical examiner, deputy medical examiner, physician, or if the decedent is under hospice care at the time of death, a hospice RN.</td>
</tr>
<tr>
<td><strong>Reportable to C/ME?</strong></td>
<td>A value of “Y” indicates this death was reportable to a Coroner/Medical Examiner (C/ME). A death must be reported to the C/ME if there were unexplained, unusual, or suspicious circumstances relating to the death. It must also be reported to the C/ME if the death was a homicide, suicide, a death following an abortion, a death due to poisoning, or an accidental death. Additionally, a C/ME must be notified if there was no physician or accredited practitioner of a bonafide religious denomination relying upon prayer or spiritual means for healing in attendance within 30 days preceding death. A C/ME must be notified if a physician refuses to sign the death certificate or when, after reasonable efforts, a physician cannot be obtained to sign the medical certification as required under s. 69.18(2)b or (c), Wis. Stats., within 6 days after the pronouncement of death.</td>
</tr>
<tr>
<td><strong>State of Incident</strong></td>
<td>Select the state of the incident.</td>
</tr>
<tr>
<td><strong>WI County of incident</strong></td>
<td>Select the county of the incident if the incident occurred in Wisconsin. This field should only be populated if an incident occurred in Wisconsin to this decedent prior to death that may have contributed to the death.</td>
</tr>
<tr>
<td><strong>Was hospice responsible for decedent care at the time of decedent’s death?</strong></td>
<td>A value of “Y” indicates that the decedent was under the hospice care at the time of death. Wisconsin defines hospice care as &quot;an agency that provides care to terminally ill persons who have a life expectancy of 6-12 months. This care can be provided in the person’s home or in another setting (e.g., nursing home, community-based residential facility, hospital).&quot;</td>
</tr>
<tr>
<td><strong>Hospice Name</strong></td>
<td>Select the state-licensed hospice from the dropdown that was responsible for the decedent at the time of death. If the hospice name is not listed, select &quot;Other&quot; and enter the hospice name in the next field.</td>
</tr>
<tr>
<td><strong>Place of Death</strong></td>
<td>Select the type of place where the decedent’s death was pronounced. If hospice was responsible for the care, “Hospice Facility” should only be selected when the death was pronounced at a stand-alone hospice facility. If hospice was responsible and the pronunciation did not occur at a standalone hospice facility, select the type of place where the death was pronounced (e.g., nursing home, hospital, residence).</td>
</tr>
<tr>
<td><strong>Hospital Type</strong></td>
<td>If the death occurred in a Wisconsin state-licensed hospital, a value must be reported in “Hospital Type” even when a hospice was responsible for care. Select the circumstances of the hospital death. For example, was the decedent an inpatient at the time pronounced, were they admitted to the ER and then died, etc.?</td>
</tr>
<tr>
<td>Facility Name</td>
<td>Select the facility name where the death was pronounced from this dropdown. If the facility is not listed, select “Other” and enter the facility name in the next field. Facility name is only available when the place of death is a hospital, nursing home, or hospice facility. For all other place of death types, no entry is required in “Facility Name.” Community-Based Residential Facility (CBRF) names are not entered in SVRIS.</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>State is defaulted to WI and cannot be changed.</td>
</tr>
<tr>
<td>County</td>
<td>Enter the county where the death was pronounced. This must be the physical county location and not a mailing county.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This field is auto-populated and disabled when the place of death is a hospital, nursing home, or hospice facility.</td>
</tr>
<tr>
<td>City, Village, or Township</td>
<td>Enter the city, village, or township where the death was pronounced. This must be the physical location and not a mailing city, village, or township.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This field is auto-populated and disabled when the place of death is a hospital, nursing home, or hospice facility.</td>
</tr>
<tr>
<td>City, Village, or Village Indicator (CVT)</td>
<td>Enter “C” for city if the location where death was pronounced is a city. Enter “V” for village if the location where death was pronounced is a village. Enter “T” for township if the location where death was pronounced is a township. This must be the physical location and not a mailing CVT indicator.</td>
</tr>
<tr>
<td></td>
<td>If the informant is uncertain if the location of death is a city, village, or township, check the Vital Records City, Village, or Township listing at <a href="http://dhs.wisconsin.gov/vitalrecords/pdf/cvtlist.pdf">http://dhs.wisconsin.gov/vitalrecords/pdf/cvtlist.pdf</a>.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This field is auto-populated and disabled when the place of death is a hospital, nursing home, or hospice facility.</td>
</tr>
<tr>
<td>Street Address</td>
<td>Enter the street address of the location where death was pronounced. This must be the physical location and not a mailing address. If a street address is not available, enter the geographic location where death was pronounced.</td>
</tr>
<tr>
<td></td>
<td>NOTE: This field is auto-populated and disabled when the place of death is a hospital, nursing home or hospice facility.</td>
</tr>
<tr>
<td>Apartment Number Designator</td>
<td>If applicable, select the type of apartment number designator (e.g., apt, unit, dept) for the place where death was pronounced.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Apartment number is required when a designator is selected.</td>
</tr>
<tr>
<td>Apartment Number</td>
<td>If applicable, select the apartment number for the place where death was pronounced.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Apartment number is required when a designator is selected.</td>
</tr>
</tbody>
</table>
### Zip Code

Enter the zip code of the location where the death was pronounced.

The zip code, while used primarily for mailing purposes, it is part of the national standard for death data collection.

The zip code will not necessarily match the city, village, or township of the physical place where the death was pronounced.

---

**Decedent Demographic Tab**

The C/ME does not complete any fields on this tab. However, the information on this tab may be reviewed and used to verify the identity of the decedent. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.

---

**Decedent Statistics Tab**

The C/ME does not complete any fields on this tab. However, the information on this tab may be reviewed and used to verify the identity of the decedent. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.
Disposition Tab

The fields on the Disposition tab will typically not require entries by the C/ME since the Funeral Director completes these items. It is only necessary to complete these fields if the record is initiated by the C/ME. Fields that are open for the C/ME entry are highlighted with a red box. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Funeral Home Name</td>
<td>Enter the name of the Funeral Home responsible for handling the body prior to burial or other disposition. If the family is in charge of the burial, enter the family member’s name that is responsible for the disposition.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>FH License Number</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>State</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>City, Village, or Township</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Mailing Address</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Apartment Number Designator</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Apartment Number</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Zip Code</td>
<td>This will be automatically filled when the Funeral Home is entered.</td>
</tr>
<tr>
<td>Funeral Director Name</td>
<td>This field is not open for the C/ME to complete and will be completed by the Funeral Home.</td>
</tr>
<tr>
<td>FD License Number</td>
<td>This field is not open for the C/ME to complete and will be completed by the Funeral Home.</td>
</tr>
</tbody>
</table>
Certifier Tab

The fields on the Certifier tab will typically not require entries by the C/ME since the Funeral Director completes these items. It is only necessary to complete these fields if the record is initiated by the C/ME or if the C/ME chooses to assign the record to another C/ME in the office. Fields that are open for the C/ME entry are highlighted with a red box. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.

<table>
<thead>
<tr>
<th>Certifier Type</th>
<th>Select the certifier type from the dropdown.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certifier’s Name</td>
<td>Select the certifier’s name from the dropdown.</td>
</tr>
</tbody>
</table>
Cause of Death Tab

All fields on the Cause of Death tab are to be completed by the C/ME or C/ME Staff. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.

<table>
<thead>
<tr>
<th>Decedent</th>
<th>Decedent Demographics</th>
<th>Decedent Statistics</th>
<th>Disposition</th>
<th>Certifier</th>
<th>Cause of Death</th>
<th>Signature</th>
<th>Amendment</th>
<th>Flag</th>
<th>Super/Misc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Identifier</td>
<td>Date Pronounced Dead</td>
<td>County of Death</td>
<td>Record Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day, Week, Year</td>
<td>05/27/2013</td>
<td>MARATHON</td>
<td>IN PROGRESS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Actual or Estimated Date and Time of Death
- Date of Death (A = Actual or E = Estimated)?
- Time of Death (Military) (A = Actual or E = Estimated)?

Other Information
- Autopsy? Did Tobacco Use Contribute to Death? Did Alcohol Use Contribute to Death? Pregnancy Status Coroner Case Number
- NOT APPLICABLE

Cause of Death
- Marielle of Death
- Part I (if reporting more than one condition per line, separate each condition with a semi-colon)
  - Immediate Cause (Final disease or condition resulting in Death) Approximate Interval - Onset to Death
  - List Conditions Leading to the Immediate Cause
    - Due to or as a Consequence of
    - Due to or as a Consequence of
    - Due to or as a Consequence of
  - Part II (if reporting more than one condition per line, separate each condition with a semi-colon)
    - Other Significant Conditions Contributing to Death

Injury - Complete if an Injury or Poisoning is Reported Anywhere in Part I or II
- Injury or Poisoning?
- Date of Injury Date of Injury (A = Actual or E = Estimated) Time of Injury (Military) Time of Injury (A = Actual or E = Estimated)?
- Injury at work? Place of Injury
- Country State/Province/Territory County
- City, Village, or Township City, Village, or Township Indicator (C/V/T)
- Injury Location Apartment Number Designator Apartment Number Zip Code
- Describe how the Injury Occurred
| **Date of Death** | Enter the month, day, and year. This is the medical certifier's approximation of the date on which all vital signs of life ceased. This date cannot be after the date pronounced dead. For non-Coronor/Medical Examiner cases, the date should be the same as, or at most one day before, the date pronounced. If the exact date is unknown, give whatever information is available, and enter "9" for each unknown value. For example, if the day is unknown but the month and year are known, enter the month and year but enter "99" for the day (11/99/2013). For reference, the date and time pronounced fields are found on the Decedent tab. |
| **Date of Death (Actual or Estimated)?** | This item is used to specify whether the date is an actual or estimated date of death. Enter "A" for Actual or "E" for Estimated. |
| **Time of Death** | Time of death should be entered using a 24-hour clock, i.e., 0000-2359. Only numeric values can be entered. This is the medical certifier's approximation of the time at which all vital signs of life ceased. This time cannot be after the time pronounced dead. If the exact time is unknown, enter “9” for each unknown value. |
| **Time of Death (Actual or Estimated)?** | This item is used to specify whether the time is an actual or estimated time of death. Enter “A” for Actual or “E” for Estimated. |
| **Autopsy?** | Indicate “Y” for Yes if an autopsy was performed. Indicate “N” for No, if an autopsy was not performed. For the purposes of this item, an external evaluation does not constitute an autopsy. Partial autopsies are included as “Yes” in the “Autopsy” field. |
| **Did Tobacco Use Contribute to Death?** | Valid responses for this item are “Yes,” “No,” “Probably,” and “Unknown.” It is commonly accepted that tobacco use contributes to many deaths due to emphysema or lung cancer. However, other deaths may be related to tobacco use. For example, tobacco use may contribute to deaths due to a wide variety of cardiovascular, respiratory, neoplastic (especially head and neck), metabolic, and other disease. Choose “Yes” if, in your clinical judgment, tobacco use contributed to the decedent’s death. |
| **Did Alcohol Use Contribute to Death?** | Valid responses for this item are “Yes,” “No,” “Probably,” and “Unknown.” Select the answer that best describes if alcohol use contributed to death. Select “No” if alcohol use played no role in the decedent's cause of death. |
| **Pregnancy Status** | Specify the decedent’s pregnancy status at the time of death, whether or not the pregnancy was relevant to the cause of death. Information from maternal deaths is shared with Public Health staff who review these deaths. For female decedents who are older than 75 or younger than 5 years of age and for male decedents, this field will populate with “Not Applicable” and you will not be required to enter any information. |
**Cause of Death - Manner of Death**

For physicians - Item 22 must be completed. Please select either “Natural” or “Pending.” If you are waiting to consult with the attending physician before completing the cause of death or waiting for the results of an autopsy or other tests, please indicate “Pending.” If you believe the manner is accident, suicide, homicide or undetermined or this death involves any injury or trauma, contact your county’s coroner or medical examiner immediately. Wisconsin state law does not allow physicians to certify these types of deaths. For Coroners/Medical Examiners - Item 22 must be complete. Please select either “Natural,” “Accident,” “Suicide,” “Homicide,” “Undetermined,” or “Pending.” If waiting to consult with the attending physician, law enforcement or for results from an autopsy or other tests, please indicate “Pending.”

**Cause of Death - Part I – Immediate Cause**

Enter the cause of death, stating the immediate cause on line A.

DO NOT enter the mode of dying such as cardiac arrest, shock, or heart failure as the sole cause of death. Do not enter vague non-disease conditions such as old age or senility. Such terms are unacceptable and render the entire certificate unsuitable for filing.

SIDS AND UNKNOWN CAUSE OF DEATH - The appropriate C/ME must sign these certificates. Unknown cause of death is acceptable only when described as being "post autopsy" or "post Coroner/Medical Examiner investigation."

**Approximate Interval – Onset to Death**

Enter the interval between onset and death. **Do not leave the interval area blank.** If the interval is unknown, enter “?” or “-”.

**Part 1 – List Conditions Leading to the Immediate Cause**

Complete “Due to or as a Consequence of” fields of lines B – D by entering health factors that may have predisposed the decedent to the immediate cause(s) of death. Enter only one cause per line and complete the interval between onset and death. The causes of death are to be listed sequentially, with the condition of shortest duration on the first line and that with the longest duration on the last line. Include the approximate interval of each health factor.

**Cause of Death - Part II - Other Significant Conditions Contributing to Death**

List any conditions which contributed to the death but which were not in the chain of events leading to death. If reporting more than one condition, separate each condition with a semi-colon.

**Injury or Poisoning?**

If no injury or poisoning is reported as part of the cause of death, enter an “N.” If an injury or poisoning is reported as part of the cause of death, enter a “Y” and complete all of the injury/poisoning fields.

**Date of Injury**

Enter the specific date of injury. If the exact date is unknown, give whatever information is available then enter “9” for each unknown value. For example, if the day is unknown but the month and year are known, enter the month and year but indicate "99" for the day (10/99/2013).

**Date of Injury (Actual or Estimated)?**

This item is used to specify whether the date is an actual or estimated date of injury. Enter “A” for Actual or “E” for Estimated.

**Time of Injury**

Enter the time of injury using the 24-hour clock, i.e., 0000 - 2359. If the exact time is unknown, use “9” for each unknown value. For example, “9999.”

**Time of Injury (Actual or Estimated)?**

This item is used to specify whether the time is an actual or estimated time of injury. Enter “A” for Actual or “E” for Estimated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injury at work?</td>
<td>Complete injury at work if there is an injury reported anywhere in the cause of death. Enter “Y” for yes, “N” for no, or “U” for unknown.</td>
</tr>
<tr>
<td>Place of Injury (specify home, street, farm, etc.)</td>
<td>Enter the place of injury. This should be a generic term, not a specific address or location. For example, home, nursing home, farm, lake, etc.</td>
</tr>
<tr>
<td>Country</td>
<td>Enter country of injury.</td>
</tr>
<tr>
<td>State/Province/Territory</td>
<td>Enter the state of injury, if injury occurred in the United States. (If not in the United States, this field will be unavailable. No entry is requested.)</td>
</tr>
<tr>
<td>County</td>
<td>Enter county of injury.</td>
</tr>
<tr>
<td>City, Village, or Township</td>
<td>Enter the city, village, or township where the injury occurred. This must be the physical location and not a mailing city, village, or township.</td>
</tr>
<tr>
<td>City, Village, or Township Indicator (C/V/T)</td>
<td>Enter “C” for city if the location where the injury occurred is a city. Enter “V” for village if the location where the injury occurred is a village. Enter “T” for township if the location where the injury occurred is a township. This must be the physical location and not a mailing CVT indicator. If you are uncertain as to the location of injury, check the Vital Records City, Village, or Township listing at <a href="http://dhs.wisconsin.gov/vitalrecords/pdf/cvtlist.pdf">http://dhs.wisconsin.gov/vitalrecords/pdf/cvtlist.pdf</a>.</td>
</tr>
<tr>
<td>Injury Location</td>
<td>Enter the street address of the location where the injury occurred. This must be the physical location and not a mailing address. If a street address is not available, enter the geographic location where the injury occurred.</td>
</tr>
<tr>
<td>Apartment Number Designator</td>
<td>If applicable, select the type of apartment number designator (e.g., apt, unit, dept) for the place where the injury occurred. NOTE: Apartment number is required when a designator is selected</td>
</tr>
<tr>
<td>Apartment Number</td>
<td>If applicable, select the apartment number for the place where the injury occurred. NOTE: Apartment number is required when a designator is selected</td>
</tr>
<tr>
<td>Zip Code</td>
<td>Enter the zip code of the location where the injury occurred. The zip code, while used primarily for mailing purposes, is part of the national standard for death data collection. The zip code will not necessarily match the city, village, or township of the physical place where the injury occurred.</td>
</tr>
<tr>
<td>Describe How the Injury Occurred</td>
<td>The description of the incident should be concise and complete. Avoid entering extraneous information that is unnecessary and may cause problems with the family. For example: do not specify that a driver was driving in an illegal manner at the time the auto accident occurred. Instead, specify only the status of the victim (driver, passenger, etc.), the type of vehicle(s) involved, and if it was a collision, rollover, etc.</td>
</tr>
</tbody>
</table>
Signatures Tab

Fields that are open for the C/ME entry are highlighted with a red box. This tab has a Record Identifier paragraph at the top. This paragraph is system generated and may be helpful in easily identifying the decedent and determining the overall record status.

### Medical Information Complete?

<table>
<thead>
<tr>
<th>Medical Information Complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you have entered all cause-of-death information in this decedent’s record, enter a “Y” in this box to indicate that the medical information is now complete. The “Completed Date” and “Completed By” fields will be automatically filled.</strong></td>
</tr>
</tbody>
</table>

### Certifier Signed?

<table>
<thead>
<tr>
<th>Certifier Signed?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enter a “Y” to indicate that the death record is certified as complete and accurate by the Medical Certifier. The “Date Signed” and “Full Name of Certifier” will be automatically filled.</strong></td>
</tr>
<tr>
<td><strong>NOTE: This field is only accessible to the C/ME listed on the Certifier tab. This field cannot be completed by a user with a C/ME Staff role.</strong></td>
</tr>
</tbody>
</table>

Once both fields have been completed with a “Y,” save the record and it will be routed back to the Funeral Director.
**Edit Screen Messages**

SVRIS contains edits that will automatically display error messages on the Data Entry Exception screen when an incorrect, questionable, or erroneous entry is made. The error message will let you know which field or fields are in error.

There are three types of messages with varying degrees of importance. The action buttons available will vary with the different types of messages.

Two of the messages must be addressed, for example, leaving a required field blank or an obvious error. These messages are:

- **Re-key the field** – Returns the user to the field for re-entry. On Re-key of date fields, hit Delete to clear the field before re-entering information.

- **Skip** – Returns the user to the next field for entry, leaving this field blank. The system will not allow you to complete a record with skipped fields. The background color of the skipped field will change to dark green.

The other type of message is a warning of an outlying value. For example, the condition “failure to thrive” usually develops as a complication of another more specific condition. SVRIS will edit “failure to thrive” when reported as the underlying cause of death. This edit checks to ensure a proper underlying cause of death is entered. If you determine this underlying cause is correct, select “Override.”
• **Override** – Indicates that the information entered was correct, e.g., “failure to thrive” is the underlying cause.

NOTE: The option for “Query Field” is not available in SVRIS.
Searching for Death Records

SVRIS has full function searching capabilities. Select the Search menu and click on the type of records to be searched, that is, Death.

Select “Death” and the search screen (shown below) will appear.

On the Search screen, note that there are two tabs – Search Criteria and Results. The Search Criteria tab, shown below, is where you enter the search criteria.

Any combination of the fields may be searched. To search by name for example, you can enter any combination of first name and last name. Once the criteria are entered, click the Search button at the bottom left of the screen (as shown below).
The Results tab will appear with all records that meet the criteria entered. The number of records found will appear at the bottom of the screen. If there are no records found, a “No Record Found” message will appear on the screen.

The Results screen may be sorted by any of the fields. Click once on the Field Name at the top of the column you wish to sort by. Only one field may be sorted at a time. Click on the field name again to sort in the field in descending order.
If the search does not produce the record desired, try to search again. To begin a new search, click the Reset/Clear button at the bottom left of the Results screen and then click on the Search Criteria tab to go back to the Search Criteria screen. This time try to enter less information in the Search Criteria to expand the search. For example, instead of John Doe, enter Doe to retrieve all records with the last name of Doe. NOTE: The system will only return the first 100 entries of a search. Should more than 100 records meet the search criteria, it is best to refine the criteria to get fewer records returned. One way to refine the search results is to enter more information. For example, enter John Doe with year of death 2014.
Using Wildcards in a search

Wildcards are characters that expand your searching capabilities. These may be used to search many of the fields in SVRIS. One of the most common wildcards is the % sign. For example, to find all last names that begin with S, enter S% in the last name field. Entering MC% in the last name and J% in the first name field will give you all records with a last name beginning with the characters MC and first names that begin with J.

Using Parameters in a search

Parameter searches will find records that meet comparison criteria. The characters in the following table may be used.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Greater than. For example, if you want to check for records after a specific time period, go to “Date Pronounced” field and enter “&gt;10/1/2013.”</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than. For example, if you want to check all records before a specific date, go to “Date Pronounced” field and enter “&lt;10/13/2013.”</td>
</tr>
<tr>
<td>=</td>
<td>If needed, equal (=) can be combined with the greater than, less than symbols (&gt;= or &lt;=).</td>
</tr>
<tr>
<td>(X+Z)</td>
<td>Values between X and Z. For example, if you want to see every record for a specific time period, go to “Date Pronounced” field and enter “(10/1/2013+10/31/2013).”</td>
</tr>
</tbody>
</table>
Amending a Death Record (Including Completing a Pending Record)

C/MEs can request an amendment to a registered death record. The C/ME will complete an amendment request and submit it to SVRO for approval.

**NOTE:** To complete a Pending cause of death, follow the same process you would use to request and complete an amendment as discussed below.

Requesting an Amendment

- Search for the record.
- Open the record.
  - Click on the File Menu.
  - Select New Event – Death Amendment.

  ![Image of Death Amendment window]

  **NOTE:** It is important to maximize this window so that the information in the amendment displays properly.

The record opens minimized. Click the square in the upper right corner to maximize the screen.

![Image of maximized record]
The screen shown below is maximized.

- From the “Amendment Type” field dropdown, select C/ME Amendment.
- Scroll down to the “Notes from Funeral Home/Medical Certifier” box.
- Enter any notes regarding the amendment.

- Open the Cause of Death tab in order to change any of the available fields.
  - There are two columns in the information fields – Current and New Values. To amend a death record, you will be completing the New Values column. Only enter fields that have changed. Do not complete fields that have not changed.
If the amendment request is an addition to information that already appears in the record, enter ALL of the information (the existing and new information). This will require that information previously reported be repeated. For example, line A. of current Cause of Death reads “congestive heart failure.” To add “heart disease” on the same line without removing the condition “congestive heart failure,” you must type “heart disease; congestive heart failure” or “congestive heart failure; heart disease.” Each condition for cause of death must be separated by a semi-colon.
• Complete the Amendment.
  ✓ Enter “Y” in “Amendment Request Complete” field. The “Completed By” and “Completed Date” fields will be automatically filled.

![Image](image.png)

✓ Save the record. This will route the request to the SVRO for approval. The record will appear in the Death Amendment Pending - MC Work Queue.

**Rejected Amendments**

If the amendment request is rejected by the SVRO, it will appear in the Death Amendment Rejected - MC Work Queue.

![Image](image.png)

To review the rejected amendment request:

• C/ME checks the Work Queue for record(s) that have been rejected by SVRO.
  ✓ Click on the Work Queue menu.
  ✓ Select Death Amendment Rejected – MC.
  ✓ In the Work Queue window, highlight the name of the appropriate record.
  ✓ To open the record, click on Display (bottom on left of the screen) or double click on the highlighted record.
• C/ME opens the Amendment tab and reviews “Notes from SVRO” for reason rejected.
• C/ME resubmits the Amendment Request.
  ✓ Enter notes “Notes From Funeral Director/Medical Certifier” box (see arrow on screen above).
  ✓ Open relevant tab (usually the Cause of Death tab) to make any necessary changes.

✓ Open Completion Tab. Change the “R” (R=rejected) in “Amendment Request Complete” field to “Y.” The “Completed By” and “Completed Date” fields will be automatically filled.

✓ Save the record. This will route the request to SVRO for approval. The record will appear in the Death Amendment Pending - MC Work Queue.
The C/ME may choose to cancel the amendment request instead of resubmitting. To cancel the request, place a “Y” in the “Cancel Amendment Request” field. The “Cancelled By” and “Cancelled Date” fields will be automatically filled.
Responding to Death Record Queries

SVRO may query the C/ME regarding a record. These queries will appear in the Query Amendment Request – MC Work Queue

To review Query Amendment Requests:

- C/ME checks the Work Queue for record(s) that have been queried by SVRO.
  - Click on the Work Queue menu.
  - Select Query Amendment Request – MC.
  - In the Work Queue window, highlight the name of the appropriate record.
  - To open the amendment record, click on Display (at the bottom of the screen) or double click on the highlighted record.
- C/ME opens the Amendment Tab and reviews the “Query Text” box.

- Then the C/ME enters notes if necessary in the “Notes From Funeral Home/Medical Certifier” box.
• C/ME changes or adds any information needed in the appropriate field on the Cause of Death tab (as discussed under “Amending a Death Record”) and/or enters a response in the “Notes From Funeral Home/Medical Certifier” box.

• C/ME completes the query.
  ✓ Click on the Completion tab.
  ✓ Enter “Y” in “Amendment Request Complete” field. The “Completed By” and “Completed Date” fields will be automatically filled.

 ✓ Save the record. This will route the query request back to SVRO.
Messaging

SVRIS contains an internal messaging function that enables users to send questions, notes, notifications, and other information about death records to other participants in the system. Since SVRIS is ID and password protected, personal and confidential information about a death record can be transmitted within the system.

Creating a Message

To access the Messaging system, go to Tools → Send Message/Email.

The following screen will appear:

- To select a message recipient, type the last name or click on the button on the right of the To: field. That will open the entire recipient dropdown list. Use the mouse to select a name from the dropdown list. You may see some people listed multiple
times. This is because they are listed once for each security role they have in the system. It does not matter which one of the duplicates you choose; it will get to the person no matter which one you pick. Follow the same procedure if you want to add a person to the CC (copy to) dropdown list.

- To select a name, highlight the name and click on the forward arrow [>] The name will appear in the recipient's box. If you selected the wrong name, highlight that name and click on the back arrow [<] to remove.
Once the recipient(s) have been selected, close that screen and return to Message and Email System screen.

- The message Priority can be changed by clicking on the Priority dropdown list.
- Enter a Subject for the message.
- If you want a Return Receipt, check that box. This will let you know when the person has opened your message.
- You also have the option to attach a file.
- Enter the information that you wish to convey in the “Message” field and click Send.
Unread Messages

If there are unread messages, text will appear in the status bar at the bottom of the SVRIS home screen informing you that unread messages are waiting in the Messages Work Queue.

- From the SVRIS Home screen, select the Work Queue menu and select Messages.
- This opens the Messages Work Queue.

A list of your messages will appear in the Messages work queue.

- Highlight the desired message.
- To open the message, click on Display (bottom left of the screen) or double-click on the highlighted message.
Replied to a Message

- Enter a “Y” in the “Read” field. If you do not enter a “Y” in this field, the message will always appear as an unread message.

- Enter a “Y” in the “Reply Back at Save Time” field. This will send a reply to the original message.

- Enter your message above the original message in the “Text of Message” box.

- Click Save. This will send the reply.

Linking a Death Record to a Message

If a user sends a message regarding a specific record, it helps if the sender links the record to the message. To link a record to a message:

- Search for and display the record that should be linked to the message.

- Click on Tools → Send Message/Email.

- Select the recipient of the message, complete the message, and click Send.

- Once the message has been sent, the recipient will see that he or she has a message and should open the Messages Work Queue.

- In the message, the fields in the Event Information paragraph indicate there is an
event record attached. To view the attached record, recipient can click on Linking \To Death Record.

- This will bring up the linked death record. To view the record, click Display (bottom left of the screen) or double-click on the record.
Death Reports

Available Death Reports

Child Death Review – 1 to 25

This report lists all death in a C/ME’s jurisdiction for decedents 1 to 25 years of age. The items on the report include: Decedent’s Name, Age, Date Pronounced, County of Death, State File Number, and Manner of Death.

Child Death Review – Under 1 Year

This report lists all deaths in a C/ME’s jurisdiction for decedents under 1 year of age. The items on the report include: Decedent’s Name, Age, Date Pronounced, County of Death, State File Number, and Manner of Death.

CME Notification Report

The C/ME Notification Report will replace the mailed or faxed copy of the Report for Final Disposition for all funeral directors that are SVRIS users. This report produces a statistical abstract for each death in a C/ME’s jurisdiction for his/her review and should consist of death records where the medical certification has been completed. This report will allow the appropriate C/ME to view all death records in a batch report rather than viewing the records individually by searching in SVRIS.

When the C/ME prints the report, it sets a flag in the record. This flag is used to remove the record from the C/ME notification queue and any future report. It is best to run this report weekly. (See “CRITICAL EXCEPTION: Wisconsin C/ME Notification Report” for more detailed discussion about printing this report.)

Death Reconciliation Report – CME

This report lists all deaths in a C/ME’s jurisdiction in which he/she had involvement. This report is designed to ensure all deaths get filed. The items on the report include: Decedent’s Name, Date Pronounced Dead, County of Death, Certifier Name, Date Signed by Medical Certifier, and Record Status.

Manner Death Not Natural

This report lists all deaths assigned to the C/ME where the Manner of Death was determined to be something other than Natural (i.e., Accident, Suicide, Homicide, Undetermined). The items on the report include: Decedent’s Name, Date Pronounced Dead, Age of Decedent, State File Number, and Manner of Death.
Pending Cause of Death – CME

This report is a summary of all death records with a “Pending” manner of Death status pertaining to a specific C/ME office, county of death, funeral home or funeral home corporation. The items on the report include: State File Number, Date of Death, Decedent’s Name, and the Coroner Case Number.

Accessing Reports

There are real time reports available in SVRIS that you can access. To access these reports:

- Click on the Batch menu.
- Select Reports.

- Click on Death under Available Reports and all the available reports will show.
- Select the report you want by highlighting and double clicking on the report.
Running (Printing) Reports

Select the desired report from the available reports listed on the left side of the screen. The parameters for the report will appear on the right side of the window. Some of the parameters will have default values and can be changed. Some parameters cannot be changed; these will display “The field is protected.”

It is recommended that you select and enter a date range parameter. The other parameters are not required. However, using parameters will speed up running the report and give better results.
In the above example, Date Pronounced Range parameter is selected.

Parameters can be typed or selected. To type the date range parameter, click on the “Create Date Range” field and type the date range separated by a comma in mm/dd/yyyy format in the Date Pronounced Range open field.

Or, to select the parameters, click on the lookup button. This will open either a list of parameters or a calendar. Select the desired parameters and click OK. Not all reports have an active lookup button.

To preview the report, click the Preview/Test Run button at the bottom of the report center. To send the report directly to a printer, click the Print/Update button. It is STRONGLY recommended to preview the report before printing. Some of the reports can be hundreds of pages long. If you select “Print,” the report will be sent directly to the printer with no preview.
If there are several pages in the report, use the page navigation arrows at the bottom of the screen (as indicated below) to advance the page.

Saving a Report

Select the “save” icon at the top left of the report (to the right of the printer icon as indicated above) and give the file a name. The report must first be saved to your C:\ drive. From there it can be moved to the desired location.
CRITICAL EXCEPTION: Wisconsin C/ME Notification Report

The C/ME Notification Report is the exception to the other reports. There are two printing options for this report. The “Print/Update” button seen below will set the “C/ME Notified” field to “Y” and the records will NOT show up on future reports. If you want the records to show up on future reports, select “Preview/Test Run” and select the print icon at the top of the report. This will print the report; however, it will not set the “C/ME Notified” field to “Y” and, therefore, the records will show up on future reports.
Printing Documents

Blank Forms

SVRIS provides blank forms to assist users in performing their work. Blank forms are available in the Blank Forms menu of the SVRIS home screen seen below. To print a blank form, select it from the list. The following forms are available for printing:

After selecting the desired document, it will open in a print preview window. To print the document, click on the printer icon at the top left of the window.
Populated Documents

Completed or partially completed documents are available for printing in SVRIS. Completed or partially completed documents can be printed from the Requests menu, when a death record is open in SVRIS.

In the example below, a death record was searched and displayed. Once the record is displayed, click on the Requests menu and select the appropriate documents to print.

After selecting the desired document, it will open in a print preview window. To print the document, click on the printer icon at the top left of the window.
Appendix

- Help Text
- Hint Text
- Review Errors and Queries
- System Preferences
  - Turning off the Error Beep
  - Changing Background Color
- SVRIS Keyboard Shortcuts
- Wisconsin Help Desk Contact Information
Help Text

Help text is provided by SVRIS for some fields. Help text assists by providing instruction on how to complete the field. To access help text, press F1 anytime you are in a field.

Hint Text

Hint text is available for some fields. Hint text assists by providing advice on proper entry for the field. To access the Hint text, hover the cursor over or near the field of entry. A message will appear with the advice for that field. Below is an example of Hint text for the decedent’s first name field.
Review Errors and Queries

The Review Errors and Queries screen displays all fields in a given record that need attention. This screen can be accessed at any time from within a record. To display all the fields in a given record that need attention, open the Actions menu and select “Review Errors/Queries.”

The fields are grouped by category: “Overridden” or Skipped” - and are color coded. See below for more details on the different colors for field edit results.

**OVERRIDE** will be shown in blue. This means that the user knows it does not meet the requirements of the edit but it is accurate.

**SKIPPED** will be shown in green. This means that an error was found but the field was skipped.

Double-click any of the entries in the Review Errors and Queries screen to be taken to that field. For example, double-clicking on the “CAUSE_INTERVAL” field found in SKIPPED status will take you to the “Approximate Interval Between Onset and Death” field in the death record. You will then be able to complete that field.
System Preferences

SVRIS allows users to set Preferences. These Preferences only need to be set once. They will remain until changed by the user. Select the Tools Menu → Preferences. Preferences consists of three tabs—Printers, Operations, and Appearance. Preferences will open on the Printers tab. This tab should be left alone. If you need assistance with your printer, contact the Help Desk at 1-866-335-2180.

The Operations tab has two items under the Data Entry paragraph. Leave the “Auto-skip” in the default setting. “Auto-skip” means that the cursor will automatically advance to the next field during data entry. Do not make changes to the Printing paragraph on this screen.

Turning off the Error Beep

The Error Beep can be quite annoying. You will want to turn this off. Mark the checkbox next to “Turn off the error beep?” Once the checkbox is checked, no beep will sound when a message or error box opens.
Changing Background Color

The Appearance tab controls color and other format items. One format you might want to change is the background color of the active field. The active field (where the cursor is located) will be highlighted in color. Click on the Appearance tab, select the “Focused Field Value” category on the left and select the desired color from the background dropdown list. In the example below, blue was chosen from the background color dropdown list.

After all changes on all relevant tabs have been completed, click the Save button.
<table>
<thead>
<tr>
<th><strong>SVRIS Keyboard Shortcuts</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New record (not available for Physician roles)</td>
<td>Ctrl - D</td>
</tr>
<tr>
<td>Move to next field</td>
<td>Tab key</td>
</tr>
<tr>
<td>Move to next Tab</td>
<td>Ctrl - Tab Key</td>
</tr>
<tr>
<td>Move to previous field</td>
<td>Shift - Tab Key</td>
</tr>
<tr>
<td>Move to previous Tab</td>
<td>Shift - Ctrl - Tab Key</td>
</tr>
<tr>
<td>Move to first field of next section</td>
<td>Ctrl - P</td>
</tr>
<tr>
<td>Clear a field – clears field where cursor is</td>
<td>Delete key</td>
</tr>
<tr>
<td>Enter today’s date in a date field</td>
<td>T</td>
</tr>
<tr>
<td>Select a checkbox ✓</td>
<td>Spacebar or click – this places a checkmark OR clears a checkmark</td>
</tr>
<tr>
<td>Close Window</td>
<td>Alt - F4</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl – S</td>
</tr>
</tbody>
</table>
Wisconsin Help Desk Contact Information  
Statewide Vital Records Information System (SVRIS) 3/15/2014

Step 1:  
FORGOT YOUR LOGIN ID (User Name) or PASSWORD?  
Go to the following website to recover your information: [https://register.wisconsin.gov](https://register.wisconsin.gov)  
Click on the Logon ID/Password Recovery link under “Forgot Your Logon ID or Password?” and follow the instructions. Note: if you unsuccessfully attempted to log on 3 times, you will need to have the Wisconsin Help Desk reset your password. If you share an email address with other users, you will need to contact the Help Desk.

TROUBLESHOOTING:  
For the following problems, first go to your facility’s IT support staff. If they are unable to help, then you should contact the Wisconsin Help Desk.

1. Internet connectivity problems
2. Hardware problems (including printers).

Step 2:  HOW TO CONTACT THE WISCONSIN HELP DESK

Local Madison Number: **608-261-4400** (Toll Free) **1-866-335-2180**
TTY: **1-888-845-4160**

**Note:** The TTY number for contacting the help desk should only be used by people who are using a TTY device. If you are calling through the Wisconsin Telecommunications Relay System provided by the phone company, you should instruct the operator to connect using the local Madison telephone or the toll-free number.

Wisconsin Help Desk Website: [http://www.helpdesk.wi.gov/](http://www.helpdesk.wi.gov/)  
Internet email: helpdesk@wi.gov

Wisconsin Help Desk takes calls 24 hours a day, every day (weekends & holidays included). See next page for details on response times.

When you contact the Wisconsin Help Desk, provide the following information:

<table>
<thead>
<tr>
<th>Help Desk Question</th>
<th>Your Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>How can we help you/What is your problem?</td>
<td>I am having problems with the “Vital Records System.”&lt;br&gt;&lt;br&gt;<strong>NOTE:</strong> It is CRITICAL that you specify “Vital Records System.” If you do not specify, your call may be misrouted and help will be significantly delayed.</td>
</tr>
<tr>
<td>Name (Last, First)?</td>
<td>Give your name (if you are calling for another user, provide that user’s information for all of the questions).</td>
</tr>
<tr>
<td>What agency or facility are you calling from?</td>
<td>Provide the name of your agency or facility.</td>
</tr>
<tr>
<td>What is the problem?</td>
<td>Be as specific as possible in describing the problem and include any error messages that you encountered (if possible, write it down so you have the exact message). Generally, problems can be categorized as follows:&lt;br&gt;&lt;br&gt;(a) Business process problems (screen navigation, starting or completing a record, searching for a record, printing a document, running a standard report, etc.).&lt;br&gt;&lt;br&gt;(b) SVRIS application problems (unable to access the application). Specify “This problem is to be given CRITICAL priority.”&lt;br&gt;&lt;br&gt;(c) Account problems (including password and logon ID issues). Specify “This problem is to be given CRITICAL priority.”&lt;br&gt;&lt;br&gt;<strong>NOTE:</strong> For confidentiality reasons, do not give the Wisconsin Help Desk information about a specific record (e.g., an infant’s name) or personal information such as your password.</td>
</tr>
<tr>
<td>Contact Information?</td>
<td>Supply the best phone number and time for a return call.</td>
</tr>
</tbody>
</table>
WISCONSIN HELP DESK

Wisconsin Help Desk Operations
The Wisconsin Help Desk is available 24 hours a day, seven days a week, including State holidays and weekends. However, the Wisconsin Help Desk cannot resolve SVRIS user problems during the initial call. Instead, Help Desk staff gathers critical information from you and routes your problem ticket DIRECTLY to the Vital Records Support Team for resolution. The Help Desk will give you a unique problem ticket number. Write down the number so you can refer to it when the Vital Records Support Team member calls you back.

Problems Reported During State Vital Records Office Business Hours: The Wisconsin Help Desk will log your call and put it in a work queue for the Vital Records Support Team. You will receive a response during Vital Records Support Team hours: Monday – Friday from 8:00 A.M. to 4:15 P.M. (except holidays).

Problems Reported Outside State Vital Records Office Business Hours: If your call is received outside normal business hours, a Department of Health Services IT support agent may return your call and attempt to answer your question if the problem is critical. However, if the problem is not a general connectivity/login problem or a system problem with the application, server, or infrastructure, you will have to wait for the Vital Records Support Team member to return your call during the next business day. See: http://www.dhs.wisconsin.gov/VitalRecords/closuredates.htm for information on State holidays.